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ABSTRACT:  

Introduction: Quality stands as an essential prerequisite in the evaluation of any product and especially true 

for pharmaceuticals, for stringent standards of quality during their manufacturing process. In this 

consideration, the Food and Drug Administration introduced good manufacturing practices (GMP) and viewed 

validation as an integral part of cGMP. Validation studies have been conducted for a long time in industries. 

In recent times to better the quality of pharmaceutical products, industries emphasize quality assurance 

programs. 

Objectives: This research has introduced a simplified and efficient method for validating Excel spreadsheets. 

The sheets are designed to fulfil the regulatory requirement, easy to use and developed itself by the users to 

assure the accuracy, integrity and quality of their data. This sheet should be validated and strictly follow the 

GMP and FDA 21 CFR part 11 regulations.  

 

Methods: All the sheets are designed in Excel- 2013 following the regulatory requirements. The data is collected 

from the analytical laboratories following the standard procedures to perform the test. 

 

Results: The sheets should validate and every action should be documented and all the sheets are assured to 

present the quality data with complete maintenance of the security, accuracy and integrity of the data. By 

following these principles, it is possible to fully validate and implement a standard spreadsheet in very less 

time. 

Conclusions: The sheets provide the accuracy maintenance of data and calculations in order to protect the data 

from any unauthorised access. The good documentation and manufacturing practices alongwith the regulatory 

authorities made it important for getting regulatory compliance. Validation of process, equipment plays 

important role in assuring the quality of product while the excel sheets ensure the data integrity and protection 

from any modification. Therefore it necessary to validate the excel sheets as per the reference documents and to 

assure quality of the data.  

 

1. Introduction 

Quality stands as an essential prerequisite in the evaluation of 

any product and especially true for pharmaceuticals, for 

stringent standards of quality during their manufacturing 

process. [1] 

In this consideration, the Food and Drug Administration 

introduced good manufacturing practices (GMP) and viewed 

validation as an integral part of cGMP. Validation studies have 

been conducted for a long time in industries. In recent times to 

better the quality of pharmaceutical products, industries 

emphasize quality assurance programs. [2] 

In the mid-1970s, Ted Byers and Bud Loftus were the two FDA 

officials, who first proposed the concept of validation. This 

concept has broadened virtue to support a wide variety of 

activities from the quality control analytical methods of drug 

substances and products to computerized systems for clinical 
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trials, research, and process control.  This term is derived from 

the word valid or validity meaning “legally defined”. 
[3]According to the FDA, "Validation" is characterized as the 

systematic procedure of gathering and analyzing data in order 

to establish scientific proof that equipment, utilities, or facilities 

can consistently produce products of high quality. [4] 

COMPUTER SYSTEM VALIDATION 

CSV (Computer System Validation) is synonymous with 

software validation. According to the FDA, validation is 

described as the process of verifying, through examination and 

presentation align with user requirements and intended 

functions, and that specific requirements have been 

implemented accordingly. 

Examination Confirmation 

• Inspect the software to ensure that it meets the user 

requirements and that it will be suitable for the intended use. 

Provision of objective evidence 

• Software requirements must be identified.  

• Documentation of all validated test results. 

User needs and intended uses 

• Software examination to ensure the fulfillment of 

user requirements 

Particular requirements implemented through software 

• Ensure that the standards can be met consistently. 

In the pharmaceutical sector, validation judgment is crucial to 

ensuring adherence to pharmaceutical cGMP rules and 

assisting businesses in maintaining consistent quality. 

Computer systems or information technology systems can still 

be validated using the same basic principles. Validation of 

computer systems examines the efficacy and efficiency with 

which the system achieves there intended goals. [5] 

They also provide custom support routine offering high-quality 

products to boost production process performance, scale back 

production prices, and improve product quality.  

Successful validation includes: 

• All standard supporting procedures are carried out 

satisfactorily 

• Proper instructions  

• Document management  

• Change control  

• Configuration management  

• Traceability specifications  

• Self-inspection and  

• Deviation management 

 

NEED OF CSV IN PHARMACEUTICAL INDUSTRY 

✓ Helps in controlling different phases of development, 

design, testing and routine of the software life cycle. 

✓ Helps deliver accuracy, security, reliability and 

consistency to pharmaceutical industry. 

✓ Helps in finding time to time error, flaws and 

mistakes (software bugs) in order to minimize data integrity. 

✓ Helps supports quality controls to ensure that the 

process is followed correctly, to reduce manual error. 

✓ Helps improve product quality, to accelerate process 

performance, and to support high quality of product. [6] 

 

ELEMENTS OF VALIDATION 

• For quality assurance 

• For time reduction 

• For process optimization 

• Better regulatory compliance 

• Increased output 

• Rapid automation [7] 

 

QUALITY ASSURANCE  

Quality Assurance (QA) is defined as all those planned actions 

needed to provide adequate confidence that products or services 

satisfy the given requirements of quality and be fit for use. It is 

the total of the activities aimed at achieving the required 

standard. [8] 

Components of Quality Assurance 

• Setting up the system 

• The Quality Manual 

• Training 

• Standard Operating Procedure 

• The Quality Assurance manager 

• Auditing and checking compliance 

• Maintaining Quality Assurance 

Functions of Quality Assurance 

• Ensures validation and qualification of designated 

formulations.  

• Qualifies batches for scaling up to production 

batches.  

• Assists in the design of validation protocols.  

• Establishes clinical programs for manufacturing bio 

batches, aiming for FDA pre-approval clearance.  

• Ensures the delivery of safe, effective, and high-

quality medicines to patients.  

• Encompasses technical and managerial activities 

necessary to fulfill all quality functions.  

• Includes documentation, review of quality control 

laboratory tests, product performance.[9,10] 

 

QUALITY ASSURANCE FRAMEWORK 

Quality holds a significant place in the identity of the Institute 

and is one of the foundational elements of UNITAR's Six-Point 

Vision, which will guide its programming in the future. [11] 

The QAF serves by incorporating these elements, the QAF 

ensures that the quality of UNITAR's training is upheld and 

provides a mechanism for continuous improvement and 

knowledge exchange in relation to quality matters. The Quality 
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Assurance Committee (QAC), quality standards and guidelines, 

and self-assessment and review processes not only contribute 

to enhancing the quality of products and services offered by the 

Institute but also offer valuable opportunities for improvement. 

Additionally, they serve as a point of reference for external 

quality certification schemes and help facilitate the Institute's 

journey towards accreditation. By implementing these 

measures, UNITAR can ensure continuous enhancement of its 

offerings and align them with recognized quality benchmarks, 

both internally and externally. The framework in brief is shown 

in (Fig.1). [12] 

 

DATA COLLECTION AND QUALITY ASSURANCE 

Data management refers to the comprehensive system that 

encompasses the gathering, purification, storage, oversight, 

analysis, and presentation of registry data. The effectiveness of 

this system plays a pivotal role in determining the data's 

suitability for achieving the registry's objectives. The database 

must conform to established quality standards, typically aligned 

with its intended functions. Additionally, specific data 

recipients might demand adherence to their individual 

guidelines or benchmarks during the data collection or 

validation processes. The framework of quality assurance 

regarding data management is shown in (Fig.2). [13] 

 

 
Fig.2 Data Management System 

 
PHARMACEUTICAL VALIDATION  

In pharmaceutical industries, validation is one of the vital parts 

of quality assurance system; it involves the regular study of 

methods, equipments, facilities and processes for determining 

whether they produce consistent and constant results as per the 

pre-determined standards. To maintain the quality of system at 

every step and not just at the end is the main aim of doing 

validation. The validation activities mainly include production 

training, Standard Operating Procedures (SOPs), people, 

facilities and processes involved in that system. A process is 

said to be validated when it provides a high degree of assurance 

that uniform batches give specified results as predicted. [14] 

The validated processes are helpful in understanding the 

Quality Management System (QMS) and also applicability of 

manufacturing processes. As per the FDA's perspective, 

ensuring the quality of a product involves meticulous and 

methodical focus on several crucial elements, which encompass 

the choice of quality processes involving both in-process and 

final product testing.[15]  

According to the World Health Organization (WHO), 

validation is described as the comprehensive process of 

gathering and assessing data across a product's entire lifecycle, 

beginning from the process design phase and extending through 

commercial production. The goal of this process is to furnish 

scientific proof that a given process is capable of consistently 

producing a product of high quality. [16] The types of validation 

in pharmaceutical industries are given in (Fig.3). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 3 Types of Pharmaceutical Validation 

 

‘V’ for Validation 

Good Automated Manufacturing Practice 

(GAMP) recommends a Software Development Life Cycle 

(SDLC) called the V-Model. The V-model as given in (Fig .4) 

in which left side gives the user demands while the right side 

gives the code modules. 

The application of calculations within the field of pharmacy is 

diverse and wide-ranging. It covers a spectrum of calculations 

carried out by pharmacists in both conventional and specialized 
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practice environments, spanning across operational and 

research domains in industries, educational institutions, and 

government entities. [18 

Fundamentals of Pharmaceutical Calculations 

Pharmaceutical calculations are the area of study that applies 

the basic principles of       mathematics to the preparation, safe 

and effective use of pharmaceuticals. To have a complete 

understanding of various types of calculations which are 

involved in dispensing, it is desirable that the pharmacist should 

have a thorough knowledge regarding the mandatory 

calculations. [19]  

 

QUALITY OF ANALYTICAL DATA AND 

VALIDATION [20] 

• Instrumental Signals  

• Calibration Methods  

➢ External Standard  

➢ One Point Calibration  

➢ Internal Standard  

➢ Standard Addition   

• Analytical Procedures  

• Validation  

➢ Specificity  

➢ Accuracy  

➢ Precision  

➢ Detection Limit  

➢ Quantitation Limit  

➢ Linearity and Range   

➢ Robustness  

➢ Test Methods in Ph. Eur. and USP  

• System Suitability  

➢ Adjustment of Chromatographic Conditions 

• Chemical Analysis of Pharmaceutical Ingredients  

➢ Pharmaceutical Ingredients, Production, and Control 

➢ Impurities in Pharmaceutical Ingredients 

➢ Impurities in Pure Chemical Ingredients 

➢ Impurities in Organic Multi-Chemical Ingredients 

• Identification of Pharmaceutical Ingredients  

➢ IR Spectrophotometry  

➢ UV-Vis Spectrophotometry  

➢ Thin-Layer Chromatography  

➢ Melting Point  

• Impurity Testing of Pharmaceutical Ingredients (Pure 

Chemical Ingredients)  

➢ Appearance of Solution  

➢ Absorbance  

➢ pH and Acidity or Alkalinity  

➢ Related Substances  

➢ Residual Solvents  

• Identification and Impurity Testing of Organic Multi-

Chemical Ingredients  

➢ Oxidizing Substances  

➢ Acid Value  

➢ Hydroxyl Value  

➢ Iodine Value  

➢ Peroxide Value  

➢ Saponification Value  

➢ Unsaponifiable Matter  

➢ Other Tests  

• Assay of Pharmaceutical Ingredients  

➢ Aqueous Acid–Base Titration  

➢ Non-Aqueous Acid–Base Titration  

➢ Redox Titrations  

➢ Liquid Chromatography  

➢ UV-Vis Spectrophotometry  

• Identification of the API  

➢ Identification by IR Spectrophotometry  

➢ Identification by Liquid Chromatography  

➢ Identification by UV-Vis Spectrophotometry  

• Assay of the Active Pharmaceutical Ingredient  

➢ Assays Based on Liquid Chromatography  

➢ Assays Based on UV Spectrophotometry   

• Chemical Tests for Pharmaceutical Preparations  

➢ Tests for related substances   

➢ Uniformity of content  

➢ Dissolution 

• Titration Calculations 

➢ Titration of a pharmaceutical ingredient and calculation of 

purity (assay) 

➢ Preparation of primary standard (0.1 M potassium 

hydrogen phthalate) 

➢ Standardization 

 

SPREADSHEETS 

The spreadsheet is a collective computer application for 

analyzing and storing data in a tabular format valid for many 

organizations. They have replaced paper-based documentation 

throughout the business world. Although earlier they were used 

for accounting or bookkeeping tasks nowadays they are used in 

multiple contexts where tabular lists are built, sorted, shared, 

and stored. [21]  

 

EXCEL SHEETS/ SPREADSHEETS /DATASHEETS 

VALIDATION  

In the laboratory, various types of equipment are used to 

examine the quality of products.  The greater challenge for 

analysts is the interpretation of the analysis data. Hence, Excel 

is the most popular software application for automatic 

calculation and data visualization. The use of spreadsheets in 

cGXP= GMP, GLP, and GDP must be controlled and validated. 

Spreadsheets are also used for testing acceptance criteria and as 

a database view tool i.e. there additional application. [22] 

These sheets should strictly follow Good Manufacturing 

Practice and the FDA 21 CFR Part 11 electronic records and 

electronic signatures regulation. A comprehensive approach in 

Live Operations 

Acceptance 

side of 

the V represents 

the specification 

stream – user 

requirements, 

functional 

specifications, 

hardware and 

software design, 

and module 

specifications. The 

right 

side of the V 

represents the 

system testing 

stream 

against the 

specifications. The 

bottom of the V 

indicates the code 

modules. 
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the development and validation of the spreadsheets is necessary 

to validate the data. Spreadsheets used must be multipurpose 

rather than single-purpose. [23] 

Eg: A spreadsheet used for more than one product or a 

spreadsheet producing multiple results for single data set. 

Like weight variation evaluation as per European 

Pharmacopeia (EU), British Pharmacopeia (BP), and 

Indian Pharmacopeia (IP). [24] 

 

BENEFITS OF SPREADSHEETS VALIDATION 

Validation is required by the FDA to ensure accuracy, 

reliability, consistent intended performance, and the ability to 

discern invalid or altered records. At Ofni Systems, we view 

validation as an opportunity to add value to your computer 

systems. Validating your spreadsheet allows you to: 

• Submit data to regulatory organizations. 

• Use data to make quality and GxP decisions. 

• Control your data and define who has access to the 

data. 

• Ensure your spreadsheet performs to specifications. 

• Query your data to better understand your business 

process. 

• Have documented evidence that your processes work 

as expected. 

• Have increased confidence in your system. [24] 

DEVELOPMENT OF SPREADSHEETS 

Designing of the spreadsheet should be:  

• In an orderly manner  

•  Data should be populated automatically, by a 

system, or manually by an operator 

• It should provide a good summary concerning its 

objective or purpose 

• It should provide well-defined operations (e.g., limit 

checks, transfer of data to other spreadsheets, online generation 

of, use of macros), and calculations. 

• Results of each individual product should be easily 

traceable.[25] 

 

KEY POINTS OF SPREADSHEETS 

1. The spreadsheets can be used easily for other 

products 

2. The spreadsheet shall be flexible to give results if 

values are changed 

3. The spreadsheet should have clear visibility of data 

used for result calculations 

4. The spreadsheet validation and revalidation should 

be performed easily 

5. The spreadsheet cells containing critical information 

should be protected to avoid any changes or manipulation. [26] 

CREATION OF SPREADSHEETS 

The spreadsheet's design should be:  

• Organized and structured 

• Data entry should be done either automatically or 

manually by the user 

• Able to summarize a clear description of its goals and 

objectives 

• Able to include clearly defined procedures (such as 

limit checks, data transmission to other spreadsheets, online 

creation, and usage of macros), computations 

• Able to provide results that are simple to track for 

each unique product. [27] 

 

OBJECTIVE OF SPREADSHEETS 

1. The spreadsheets are simple to utilize for different 

goods 

2. The spreadsheet must be adaptable to produce results 

even if values alter. 

3. The data that is utilised to calculate results should be 

readily visible in the spreadsheet. 

4. It should be simple to validate and revalidate the 

spreadsheet. 

5. To prevent modifications or manipulation, the 

spreadsheet cells holding important data should be secured. [27] 

 

APPROACH TO SPECIFIC PART 11 REQUIREMENTS 

Title 21 of the Code of Federal Regulations Part 11 (21 CFR 

Part 11) is a set of regulations established by the U.S. Food and 

Drug Administration (FDA) that specifically governs electronic 

records and electronic signatures in the context of 

pharmaceutical, biotechnology, and medical device industries. 

These regulations outline the requirements for the use of 

electronic systems in capturing, storing, and managing data that 

is subject to FDA regulations. Compliance with 21 CFR Part 

11 is crucial for companies operating in FDA-regulated 

industries to ensure the integrity, confidentiality, and 

authenticity of electronic data and to maintain regulatory 

compliance. It covers aspects such as the security of electronic 

records, validation of computer systems, audit trails, electronic 

signatures, and documentation practices as shown in (Fig.1.5) 

.[28] 

 

21 CFR Part 11

Validation

Audit Trail

Record Copies

Electronic 
Records

Electronic 
Signatures

Record 
Retention

Fig. 5 Criteria for 21 CFR Part 11 
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OVERVIEW OF EXCEL SPREADSHEET 

Spreadsheet software of today can contain numerous 

interconnected sheets, execute basic mathematical and 

arithmetic operations, and display data either graphically or as 

text and numbers. For typical economical and scientific 

activities, it offers integrated functions. In contrast, a 

spreadsheet manipulates numerical data, text and the formula 

or the information. Spreadsheet can be useful in creating 

budgets, data analysis, financial planning, and to perform the 

critical numerical operations. These sheets have tendency of 

automatic recalculation, self feeded formulas by the user, or by 

default included math functions, along with this changes in 

already given command or formulas could also be seen 

enhances the monitoring and error findings. [29]  

How to start Excel 

• Go to START OPTION on the windows taskbar 

• It can be find in the search bar as well 

• Click on MS- Excel option, the window appears as 

shown in (Fig.1.6). [30] 

 

 

 

 

In the (Fig.1.7) given below the large window, labeled 

"Microsoft Excel" may take up the entire screen. This is 

referred to as the Application Window. The top line is called 

the Title Bar and has three buttons (Minimize, Restore, and 

Close) to the right. These buttons are used to size the window 

and close it. This title bar is standard in all Windows programs. 
[30] The second line is called the Menu Bar. Notice that one 

character of each selection is highlighted or underlined. This 

menu bar is also standard in all Windows programs. The next 

two lines contain buttons with text or images and are referred 

to as the Standard and Formatting Toolbars. If you have a 

mouse, these toolbars allow you to enhance your worksheet 

without accessing the menu. Keep in mind that these may not 

be in the exact same place as on the illustration above. All 

toolbars can be customized to display any buttons you desire. 

[31] The next line is the Formula Bar and displays the current 

cell address and contents. As you move from cell to cell, Excel 

will keep track of the current cell address for you. The Formula 

Bar can also be used to edit the text (contents) or formulas 

contained in the cell. [32] 

The Excel Screen 

 
Fig.7 MS - Excel Screen 

 

2. Objectives 

NEED OF SPREADSHEET VALIDATION 

During an FDA inspection of a QC analytical laboratory in a 

pharmaceutical firm, several spreadsheet problems were 

identified. These problems indicate a failure to adhere to 

current good manufacturing practice (cGMP) and good 

laboratory practice (GLP) regulations. Furthermore, the 

laboratory lacked proper multi-user spreadsheet design, 

validation, and documentation practices. Some specific 

problems observed in the laboratory include as described in 

(Fig.1.8). [33] 

There are some more problems as follows: 

• One specific problem identified in the QC analytical 

laboratory was the presence of rounding-off errors in nearly all 

the spreadsheets. Rounding-off errors can occur when 

numerical values are truncated or approximated without 

considering the appropriate rounding rules. 

• Proper excel equations are not followed to put 

formulas into the sheets.  

• No expressions of conversion factors in the sheets.  

• Unmatched formulas used for manual calculations 

and excel calculations.  

• The standard limits were not mentioned in the 

spreadsheets.  

• No clear documentation of spreadsheets.  

For example, No clear indication of product statement 

replacing it by number in a cell. 

• No labels such as mg/g, mg/ml is provided for unit 

expressions. 

• No provision to maintain data integrity and security.  

• Sheets are not protected from unauthorized changes 

and access. [34] 

Search bar 

 

MS- Excel 

 

Fig. 6 MS - Excel  
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Current Position 

http://www.jchr.org/


 
 

 

164 

Journal of Chemical Health Risks 

www.jchr.org 

JCHR (2023) 13(6), 158-188 | ISSN:2251-6727 

Unique designing of these analytical spreadsheets by the user 

itself can remove these errors. A modest confirmation 

document must have following points:  

• Properly describe the programme, its use and 

working. 

• Entries of data should be color coded.  

• Properly described calculation formulas.  

• Appropriate relationship between excel equations 

and formulas.  

• Macro functions must be listed. [35] 

• Investigation sheets with projected and authentic 

outcomes, contracted and studied, that have been confirmed by 

physical calculations. 

• Properly secured and password protected.  

• Installation date, version no. and system type. 

 

SPREADSHEET DESIGNING 

The framework of an Excel spreadsheet is almost identical to 

that of an electronic programme. Spreadsheet formulas are 

essentially a type of computer code. Alternative to generate the 

template file and then verifying for mistakes, check for 

problems throughout the different phases of the creation 

process. A spreadsheet model is a collection of spreadsheets 

and custom sheets that are used to analyse and organize data or 

to solve a specific issue. This designing in appropriate format 

is shown in (Table 1.1) [18]. The sheets shall be designed in 

such a way that they are easy to understand and to ease the 

complexities of handling data generated from different 

analytical procedures, validated excel spreadsheets containing 

relevant formulas are developed to ensure the process of data 

handling will consistently produce the expected results. [36] 

 

Table 1 Steps of Spreadsheet Designing 

S.No STEPS DESCRIPTION 

1. 
Flexible 

Designing 

• Vertical 

calculation scheme should 

be promoted. 

• All the formulas 

should be written above its 

respective cells [19]. 

• Proper color 

formatting, border style and 

color should be done 

appropriately [20]. 

2. Typical Outline 

• Documentation – 

Must contain the title, scope, 

author name, list, macros 

and outlines. 

• Menu – A one 

click consist of user 

instructions such as drop 

down list, data entry location 

etc. 

• Conventions – 

Consist of assuming data in 

the sheets. 

• Manuscript 

expectations – Transparent 

documentation of 

assumptions made in 

formulas.  

• Data- This file 

contains raw data, such as 

data records from which the 

model will execute 

computations. 

• Calculations – 

Division of sheets into series 

computation stages, and the 

make one sheets with 

different series and stages. 

etc. 

• Results – The end 

part should contain the final 

conclusion alongwith the 

predictions done [22].    

3. 
Clear Visibility 

of formulas 

• Ensures flexibility 

of model by reducing 

recalculations. 

• Formula shall be 

written into different cells 

instead of writing it in single 

cell, give cell comments 

wherever needed. 

4. 
Control 

Measures 

• Checks and 

control measure shall be 

included such as “IF and 

ERROR conditions to avoid 

mistakes such as #N/A, 

2. Absence of 

Standard 

Operating 

Procedure  

3. Insufficient 

Documentation 

Improper, 

unorganised 

data 

maintenance 

1. Lack of 

Spreadsheet 

Maintenance 

 
Improper, 

unorganised 

data 

maintenance 

 

Clear 

instructions 

on the usage, 

consistency 

and 

compliance 

 

Improper 

documentation 

and 

compliance 

 

Fig. 8 Some specific problems of spreadsheet validation 
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#VALUE!, #REF!, #NUM!, 

#NAME?  

 

STEPS IN PERFORMING VALIDATION  

The steps followed while performing the validation are as 

follows: 

Validation Planning 

 

 
A comprehensive document consisting of actions done, 

approaches, schedule and validation activities. 

Validation procedure 

 

 

The validation procedure should be divided into an Installation 

Qualification (IQ) and Performance Qualification (PQ) [23]. 

Installation Qualification 

 

 

It consists of the points to establish the confidence that the 

results are in compliance with the regulations. 

Performance Qualification 

 

 

PQ will systematically, strictly and constantly test the software 

by testing all involved and resultant values, records, procedure, 

and control flow logic [24]. 

Validation report 

 

 

The verification report should include complete validated 

results, particularly the outcomes of the tests. When feasible, 

evaluations should be reported quantitatively rather than as 

"pass/fail." Qualified authority must assess and consent to the 

report. 

Validation Lifecycle 

 

 

 

It consists of preservation, controlling and maintenance of the 

validated sheets. These controls include computerized systems 

and it compliance with the regulations. Some controls to 

support the system includes 

• Preventive Maintenance 

• Environment Control 

• Monitoring of performance 

• Retention 

• Recovery 

• Training to users, developers and administrators 

 

Validation Documentation 

 

 

 

 

The following points should be considered while validating an 

excel sheet as described in (Fig 1.9). Every worksheet taken 

into process must be fully documented consisting of all 

formulas, macros, and user interface elements alongwith their 

copies in the validation documentation [25]. 

Operational Change Control 

 

 

 

Changes to spreadsheet apps must be managed while in use. 

This modification management must be established from the 

stage in the creation life cycle where an individual begins to use 

the programme and will continue throughout the application's 

existence. [37] 

 

DATA 

Data are quantitative or qualitative facts, figures and statistics 

collected for reference or analysis.  

 

Development of Requirements 
  

Proper Flexibility Testing 
 

Proper use of excel auditing 

tools 
Performance Testing 

should be done 

Error messages 
  

User Instructions 

Data Validation 

Fig. 9 Elements of Validation Documentation 
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Data may be captured or recorded:  

• By manual recording, on paper or in an electronic 

system, of an observation or of an activity;  

• By automatic recording, on paper or in an electronic 

system, using equipment that range from simple instruments 

through to complex highly configurable computerised systems 

• Using a hybrid system where combinations of paper 

and electronic records constitute the raw data  

• On other means of media such as photography, 

imaging methods and technologies, etc. could be generated 

manually, automatically or by hybrid system. 

 

Configuration Management:  

➢ Quality assurance for managing software addresses 

all documentation associated with the system and is applied 

during all operational phases of software use, including the 

development and maintenance phases. [37] 

 

DATA VALIDATION 

Data validation is the activity where one decides whether or not 

a particular data set is fit for a given purpose. The decision is 

based on testing observed data against prior expectations that a 

plausible dataset is assumed to satisfy. A straightforward 

formalization is to define it as a function from the collection of 

data sets that could have been observed to True or False.  

 

DATA INTEGRITY  

➢ It is  done to avoid intentional, accidental falsification or 

deletion of data to withstand data quality during regulatory 

inspections 

➢ Data integrity and security infractions are not only 21 

(CFR) Part 11 issues, but also severe cGMP violations. 

➢ It plays a very crucial role in USFDA audit. It is important 

to back up the data containing valid reports from the entire 

department.  

➢ It is important to ensure the data quality in order to offer a 

quality product to fulfill the customers’ requirements. 

➢ It is a critical aspect of data management and is 

essential for ensuring that data is trustworthy and can be relied 

upon for making informed decisions, conducting research, or 

supporting business operations. [38] 

 

TYPES OF DATA INTEGRITY 

On the basis of mechanism and data integrity stream integrity 

can be divided as shown in the (Fig 1.10).  

 
LOGICAL INTEGRITY (LI) 

It is a crucial component of DI since it involves a physical 

integrity procedure and safeguards data from human mistake, 

piracy, and data hackers. In the pharmaceutical sector, logical 

integrity is crucial for the preservation and processing of data 

collected from the appropriate department.   

 

REFERENTIAL INTEGRITY (RI) 

Integrity can take many different forms, including procedures 

and the application of laws related to data storage and retrieval. 

Foreign keys are a crucial component of referential integrity.  

 

USER-DEFINED INTEGRITY (UDI) 

Data acquired via post-marketing monitoring and information 

gathered from pharmacovigilance supervisors is specific to a 

certain group of people in the pharmaceutical sector. The 

process of integration requires that the data be user-defined.  

 

DOMAIN INTEGRITY (DI) 

Because the operational records of the pharmaceutical sector 

contain many different sets of regulations and processes, this 

data may be streamlined and saved by using the DOI technique.  

 

PHYSICAL INTEGRITY (PI) 

There are several ways in which different elements might 

impact the data integrity process and storage. One of the 

elements outside of one's control is one's wishes. Earthquake, 

flood, tsunami, tornado, and hailstorm are a few examples of 

natural disasters that might interfere with how data integration 

is stored and retrieved. Data storage and protection can greatly 

benefit from the application of physical integrity and its 

operating principles. 

 

GOOD LABORATORY PRACTICE (GLP) ON DATA 

INTEGRITY [OECD, 2021] 

One of the fundamental purposes of the Principles of Good 

Laboratory Practice (GLP) is to ensure the quality and integrity 

of test data. This includes the increasing use of electronic data 

capture, integration and automation of systems and other 

technologies. However, the main purpose of the requirements 

1.  LOGICAL INTEGRITY 

2.  REFRENTIAL  INTEGRITY

3. USER-DEFINED INTEGRITY

4. DOMAIN  INTEGRITY

5. PHYSICAL INTEGRITY

Fig. 10 Types of Data Integrity 
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of the Principles of GLP remains the same in having confidence 

in the quality and the integrity of the data. [39] 

 

WORLD REGULATORY GUIDANCE ON DATA 

INTEGRITY:  

• USFDA: 21-CFR: The Code of Federal Regulation 

(CFR) is a codification of the general and permanent 

regulations that the executive departments and agencies of the 

federal government have published in the Federal Register. The 

Food and Drug Administration's regulations are included under 

Title 21 of the CFR. The CFR is updated once a year on or 

around April 1st of each year for each title/volume. 

• MHRA: The MHRA's guideline on GMP data 

integrity requirements for the pharma sector is meant to 

supplement the EU's current GMP standards for dosage forms 

and active ingredients. The pharmaceutical quality system, 

which guarantees that medications are of the requisite quality, 

is fundamentally dependent on data integrity. 

• TGA: The Therapeutic Goods Administration 

(TGA), an Australian regulatory organization, specifies the 

need for data integrity as a deficit. A flaw in a procedure that 

might lead to a considerable risk of creating a user-harmful 

product. 

• WHO: Vital drugs and medical supplies, WHO 

releases data integrity recommendations to safeguard patients 

worldwide. In order to lessen instances of manufacturers 

providing inadequate data or purposeful data fabrication, has 

WHO produced a guideline on worldwide best practices for 

regulatory bodies and inspectors while we are creating a 

medication and marketing it.  

• EME: To guarantee the integrity of data generated 

during the testing, production, packaging, distribution, and 

monitoring of medicines, the European Medicines Agency 

(EMA) has published new Good Manufacturing Practice 

(GMP) guidelines. Effective data record management enables 

regulatory agencies and pharmaceutical producers to make 

informed decisions by ensuring that the data produced are 

correct and consistent.  

 

DATA LIFECYCLE  

Data life cycle management is very much useful for any 

enterprise or application where data is being used and 

processed for producing results. The lifecycle is the 

development phase to the release and retention of the data. It 

plays an important role in easy flow processes including data 

collection. It starts from creation, store, usability, sharing, and 

archive and destroy in the system and applications The different 

steps of data lifecycle includes data approval, Transcription, 

Data processing, Data migration, Computerised system 

transition, Data retention, Backup and Archive as shown in 

(Fig.1.11)  

 

 

ALCOA 

"ALCOA" is an acronym used in the pharmaceutical and 

clinical research industries, as I mentioned earlier. It is used to 

ensure data integrity and accuracy in the recording of data 

during clinical trials and research studies. Each letter in the 

acronym represents a fundamental principle that should be 

followed when collecting and documenting data: The FDA uses 

ALCOA to define its expectations of electronic data as shown 

in [Fig.1.12].  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Attributable: All data should be attributable to the person who 

performed the original observation or data entry. When the 

record has been completed, it is advised that you use permanent 

ink. This method guarantees that the record remains readable. 

It should be persistent and readable in all scenarios.  

Legible: The data of records involved in maintaining the data 

integrity must have appropriate accessibility during the entire 

duration of action. Data should be recorded in a clear and 

readable manner.  

Contemporaneous: All the data are documented during the 

entire course of action. It records important information from 

several sources into the proper useable data in chronological 

series.  

Data 
Approval

Transcription

Data 
Processing

Data 
Migration

Computrised 
System 

Transcition

Data 
Retention 

Backup

Archive

Original: Data should preserved in its original form 

or a certified true copy 

Legible: Easy to understand, record and preserved 

in original form 

Fig. 11 Data Lifecycle 

 

A 

A 

L 

O 

C 

Accurate: Data should be free from error and as per 

the protocol 

Contemporaneous: Data should be recorded on 

time 

Attributable: Who performed the action and when? 

Fig. 12 ALOCA 
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Original: The genuine or accurate copy of the raw data must 

be given. Original data should be preserved and maintained 

throughout the study. [52] 

Accurate: Data must include complete meaning and should be 

correct. Use an observation check for the purpose of basic 

record collecting to confirm the correctness of the information. 

[40] 

3. Methods 

Validation Approach 

A broad approach to spreadsheet validation has similarity to 

that of the computerised system validation. The process of the 

validation consists of same steps (user requirements, risk 

assessments, provisions, design, challenging, reporting), the 

project accountabilities, appropriate validation documents, and 

rules for the archival and change management processes.  

 Development Process 

The V model is the most commonly adopted approach to 

develop protocol for validation. The protocol is developed for 

various calculations and operations involved in pharmaceutical 

industries. Some of the major tests includes IPQC test, Assays, 

Molarity, Normality etc. The sheets and the process must be 

easy, reliable and adaptable in order to make it easy for the 

developer and user to make useful to maintain data integrity and 

security throughout the operation.  

User Requirements 

The first step in the development of spreadsheet as per the User 

Requirements Specifications Guidelines (URS) is to capture the 

user’s spreadsheet demands.  

User Requirement Specification for Molarity and 

Normality determination spreadsheet: 

URS‐1. The spreadsheet should be applicable for all 

parameters. 

URS‐2. The spreadsheet should be easy and quick to determine 

the given conditions. 

URS-3. The format of spreadsheet should have Test name, 

Sheet code, Standard taken with proper headings. 

URS‐4. The spreadsheet should standard reference, calculation 

formulas and also the instructions wherever needed. 

URS‐5. The spreadsheet should use the Unique ID No. for 

specific compound in the form of dropdown list wherever 

applicable. 

URS‐6. The spreadsheet should indicate invalid entries with 

error messages and numerical value entries or any specific 

entries. 

URS‐7. The spreadsheet input should only allow text, date, 

time and signatures as well alongwith the approval details. 

Requirements concerning security, protection and GLP 

compliance must also be taken into account. 

URS‐8. The calculations in the spreadsheet should be protected 

against unauthorised modifications. 

URS‐9. The sheet should have color coding system for input, 

output cells and locking and unlocking system for formula 

cells. 

URS‐10. After completion of the calculation, the spreadsheet 

should be initialed, dated and put time electronically by the 

user. 

URS‐11. Making changes to the spreadsheet 

(modification/deletion) after signing off (initials/date) should 

not be possible. 

URS‐12. The spreadsheet template and completed spreadsheets 

should be retained in a secure location in an electronic form 

with access control in the form of worksheet protection. 

URS‐13. The sheet should consist of the macro code and audit 

trail. 

Designing of Excel sheet  

The designing of the spreadsheet is related to the system 

and version of the program and a worthy design ensures 

the: 

• Reduction of mistakes while operating the sheets. 

• Easily understandable, adaptable and versatile. 

• Easy verification of the formulas and cells to inhibit 

unauthorised access. 

Security, Error messages and Password 

• Data entry is secured by error messages, dropdown 

list and for time, date entries. 

• Date and time should be electronically feeded with 

signatures of authorized personnel’s respectively. 

• Error messages should be there for invalid entries 

into the cell. 

• The template is password‐protected (at sheet, 

workbook and VBA code level). 

• Defined location to save worksheet template and to 

perform straightforward validation. 

• All the information required for verification should 

be provided in the hardcopy and screenshots. 

Development of Spreadsheet  

• The sheets are developed based on the User 

Requirement Specifications (URS). 

• The sheets should be designed systematically. 

• The user should include all the recommendations as 

per URS step by step. 

• In case of Macro or VBA code recording should be 

done by manual operations automatically. 
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• The code should be checked to ensure the correct cell 

references. 

• At very first step user or the developer check the 

spreadsheet, cells, references and input values as per the user 

requirement. This is done by the set of typical data. 

Review of codes 

• These codes should be evaluated twice by the 

developer and the experienced personnel who are accustomed 

with the planned use and functionality. 

• In excel sheets it includes inspection of cell content, 

especially formulas, formula locations, cell numbers and 

ranges, syntax of additional functionality, and VBA code. 

• The content and reference of the cell can be evaluated 

by auditing the formula cells, dropdown list by zooming and 

scrolling to check mouse sensitivity. 

• Formula Auditing Tools in Excel by doing following: 

1. Trace Precedents. 

2. Remove Arrows. 

3. Trace Dependents. 

4. Show Formulas. 

5. Error Checking. 

Trace Precedents 

• The “Trace Precedents” command can be seen in 

the “Formula Auditing” group under the “Formulas” tab to 

trace precedents as shown in (Fig.13) 

 
Fig. 13 Trace Precedents Command 

 

• To select the formula cell and click on the “Trace 

Precedents” command. 

• To check the formula’s precedents, press F2 to get 

into edit mode after selecting the required cell so that 

precedents cells.  

Remove Arrows 

• We can use the “Remove Arrows” command in 

the “Formula Auditing” group under the “Formulas” tab to 

remove these arrows as shown below in (Fig.14). 

 
Fig. 14 Remove Arrow Command 

 

Trace Dependents 

• This command traces the cell, dependent on the 

selected cell.  

• The “Trace Dependents” command can be seen in 

the “Formula Auditing” group under the “Formulas” tab to 

trace precedents as shown in (Fig.15). 

• The formula weight of the compound, to know how 

much weight of the compound is needed.  

 
Fig.15 Trace Dependent Arrow 

 

Show Formulas 

• This command to display formulas written in the 

excel sheet. 

• The “Show Formulas” command can be seen in 

the “Formula Auditing” group under the “Formulas” tab to 

trace precedents as shown in (Fig.16). 

 
Fig.16 Show Formula Command 
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Error Checking 

• Select the cell where the formula or function is 

written, then click “Error Checking.” from “Formula 

Auditing” group as shown in (Fig.17). 

 
Fig.17 Error Checking Command 

 

5.5.6. VBA Code 

• To enter the code go to: Developer tab< Record 

Macro< Give Macro name, Shortcut key, Destination to 

save and a short description of macro as shown in (Fig. 18) 

 
Fig.18 VBA Code Command 

 

Qualification Process 

The qualifying method's goal is to establish that the created 

spreadsheet is fit for its intended use. It must be proved 

throughout the entire procedure that the desired outcome - is, a 

collection of processed data that has been subjected to 

operations such as computations, rounding, formatting, and 

regrouping for presentation as a table, chart, or report - is 

achieved in an accurate and repeatable manner. 

 

Installation Qualification (IQ) 

A spreadsheet design is a vital document since it often contains 

the whole source code (VBA code and Excel functions) and 

may be used to run the programme.  

Operational Qualification (OQ) 

In the development phase user requirements are tested 

systematically. It is not compulsory to perform all test but some 

basic functions are checked. The entire test should be 

performed with independent data sets.  

Performance Qualification (PQ) 

The main purpose of this last qualification stage is 

demonstration of the spreadsheet by giving various commands 

as per the user’s requirements. It is observed as the internal 

acceptance test. It can be done regularly by the future users. 

 

Spreadsheet Accuracy Test 

A. IPQC Test of TABLETS 

 Layout 

• The spreadsheet is divided into an input area 

(yellow), an output area (green) and an area for verification of 

constants and specifications  

• The Freeze Pane is included by: Home > View> 

Freeze pane  

• The color coding of cells was done containing 

formulas. 

• To view the formulas in Excel: Tools > Options > 

Tab: View and check “Formulas” under Window options; 

Formulas > Formula Auditing > Show Formulas 

Security and Protection 

Password Protection 

• The protection of spreadsheet as well as worksheet 

both is important in order to avoid the unauthorised access for 

security purpose. 

• To do any editing in the sheet the user needs 

password to access the sheet, these passwords are unique to 

individual sheets and one unique password is set to protect the 

worksheet containing this spreadsheets. 

• To Protect Worksheet: File > Info > Protect 

Worksheet > Choose option as shown in (Fig. 19) 

•  
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Fig.19 Worksheet Protection Window 

 

• To protect spreadsheet go to: Home > Format > 

Protect Sheet  

                             

 

Fig.20Spreadsheet Protection Window 

 

Cell Locking 

• Cells containing formulas, sheet code, and Batch no. 

and test name are locked.  

• To Lock Cell go to Home > Format > Fromat Cells 

> Protection as shown in (Fig.5.9)   

 
Fig.21 Cell locking Window 

Logical Formula 

• Microsoft Excel provides 4 logical functions to work 

with the logical values. The functions are AND, OR, XOR and 

NOT as given in (Table.5.1) 

• These functions are used to compare formula or 

several test conditions instead of just one.  

• As well as logical operators, Excel logical functions 

return either TRUE or FALSE when their arguments are 

evaluated.  

• To insert it: Home > Formulas > Insert Functions  

Table 2 Logical Formulas 

Function Description 
Formula 

Example 

Formula 

Description 

 

 

 

AND 

 

Returns 

TRUE if all 

of the 

arguments 

evaluate to 

TRUE. 

=AND(A2

>=10, 

B2<5) 

The formula 

returns TRUE 

if a value in 

cell A2 is 

greater than or 

equal to 10, 

and a value in 

B2 is less than 

5, FALSE 

otherwise. 

 

 

 

 

OR 

 

Returns 

TRUE if any 

argument 

evaluates to 

TRUE. 

=OR(A2>

=10, 

B2<5) 

The formula 

returns TRUE 

if A2 is 

greater than or 

equal to 10 or 

B2 is less than 

5, or both 

conditions are 

met. If neither 

of the 

conditions it 
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met, the 

formula 

returns 

FALSE. 

 

 

 

XOR 

 

Returns a 

logical 

Exclusive 

Or of all 

arguments. 

=XOR(A2

>=10, 

B2<5) 

The formula 

returns TRUE 

if either A2 is 

greater than or 

equal to 10 or 

B2 is less than 

5. If neither of 

the conditions 

is met or both 

conditions are 

met, the 

formula 

returns 

FALSE. 

 

 

NOT 

Returns the 

reversed 

logical value 

of its 

argument. 

I.e. If the 

argument is 

FALSE, 

then TRUE 

is returned 

and vice 

versa. 

=NOT(A2

>=10) 

The formula 

returns 

FALSE if a 

value in cell 

A1 is greater 

than or equal 

to 10; TRUE 

otherwise. 

 

Calculation Formula 

• The formula used in these sheets as per the 

calculation requirements. 

• The formulas used in these sheets are based on their 

usage in the sheets. 

• In the calculation and results worksheet, each 

calculation should be based on the results of the previous 

calculation so that the calculations progress through the 

worksheet from top to bottom. 

• They are used to make calculation easy and simple to 

understand 

Conditional Formatting 

• It consist of command where conditionally format 

cells in a range that have duplicate text, unique text, and text 

that is the same as text you specify.  

• Select the cells you want to apply conditional 

formatting to. Click the first cell in the range, and then drag to 

the last cell. 

• Click HOME > Conditional 

Formatting > Highlight Cells Rules > Text that Contains. In 

the Text that Contains box, on the left, enter the text you want 

highlighted. 

• Select the color format for the text, and click OK as 

shown in (Fig.22) 

 
Fig. 22 Conditional Formatting Command 

 

• Now choose the color formatting for as per the user 

requirement as given in the (Fig.23) 

 
Fig.23 Cell Colour Format 

 

DATA VALIDATION 

Drop Down list menu  

• For more quicker and accurate data entry dropdown 

list menu is useful as it can limit the entries people can make in 

the cell. 

Steps to create a drop – down list 

a. Select the cell you want to contain the lists . 
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b. On the ribbon, click DATA> Data Validation as 

shown below in (Fig.24) 

 

 

Fig.24 Data Validation Tab 

 

c. In the dialog box, set Allow to List as given in 

(Fig.25) 

 
Fig.25 Validation Criteria 

 

d. Put the data in list you want to see in drop down list as shown 

in (Fig. 26) 

Fig.26 List Data 

 

Data Input and Error messages  

• The cells use the data validation functionality in 

Excel (Data > Validation Data > Data Tools > Data 

Validation).  

• With this functionality, such as wrong entries of 

alphabets, text, decimals and so on with their respective error 

messages. 

VBA Code 

• The Office suite of applications has a rich set of 

features. There are many different ways to author, format, and 

manipulate documents, email, databases, forms, spreadsheets, 

and presentations.  

• The great power of VBA programming in Office is 

that nearly every operation that you can perform with a mouse, 

keyboard, or a dialog box can also be done by using VBA.  

• Further, if it can be done once with VBA, it can be 

done just as easily a hundred times. (In fact, the automation of 

repetitive tasks is one of the most common uses of VBA in 

Office.) 

• Insert VBA code to Excel Workbook by following 

this steps 

1. Open your workbook in Excel. 

2. Press Alt + F11 to open Visual Basic Editor (VBE). 

3. The window appears after giving this command is 

described in (Fig.27). 

 
Fig. 27 VBA Window 

 

4. Right-click on your workbook name in the "Project-

VBAProject" pane (at the top left corner of the editor window) 

and select Insert -> Module from the context menu as shown 

in (Fig.28). 
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Fig.28 VBA Project Explorer 

 

Audit Trail 

Audit trails are obligatory for computerized systems falling 

under FDA/EU regulations. These logs are essential to 

document the inception, alteration, and removal of controlled 

digital records. During system validation, the accuracy and 

alignment of the audit trail with regulatory and organizational 

standards should be confirmed. Subsequent to successful 

validation and system deployment, the significance of the audit 

trail must not be overlooked. 

To attain audit trail in spreadsheet:  

1. It is important to create audit trail to track changes 

made to formula and data cells in the sheets. 

2. To do this, go to the “Review” menu and select 

“Track Changes” as shown in (Fig.29). 

3. The required changes are done for being tracked and 

can be assembled into the list in a new sheet. 

 
Fig.29 Track Changes Command 

 

 Excel Auditing Tool and Watch Window 

1. Excel’s auditing tool is used to determine the errors 

in formulas and data cells. 

2. To do this, go to the “Formulas” tab and select 

“Error Checking”, “Watch Window” as given in (Fig.30). 

3. Formula auditing can be done by using the watch 

window as it allows the effect of change in one cell on the other. 

4.  

 
Fig.30 Excel Auditing Tools 

 

5. To set watch window: Click on the cell containing 

formula> Watch Window>Add watch to the cell as shown 

in (Fig.31). 

 
Fig.31 Add Watch Window 

 

 Addition of Hyperlink  

• The hyperlinks are added to get information either 

from another file, web page or image. It can be inserted in a 

particular cell of worksheet or the chart element. 

• It can be done by using ‘Insert Hyperlink' dialog 

box in Excel or by using Hyperlink function as shown in 

(Fig.32) 

•  

Fig.32 Hyperlink Command 

 

•  To add a hyperlink to the current file, should be 

selected from the list as shown in (Fig.33). 
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Fig.33 Hyperlink List 

Validation Protocol  

It is a documented plan consisting of all the experiments, their 

designing and the procedure to carry out the validation. This 

plan is a written procedure which consists of all the information 

such as product description, testing parameters, production 

process, planning and the acceptance criteria. Validation 

protocol consists of two major points such as: 

• Procedure: It defines the steps involved in the 

procedure of the validation.  

• Form: It is the documentation of the any change or 

modification done in the pre-approved validation protocols. 

• Parts of Validation Protocol 

• The important parts to be included in the protocol are 

described in (Table 3): 

 

Table 3 Validation Protocol Parts 

S.no Parts Description 

1. 
Protocol 

Approval 

It shall be done by the 

concerned departments and 

taken for final approval from 

quality assurance department. 

2. Purpose 
It includes the objective to 

made validation protocol. 

3. Scope 

It includes the specific 

departments following this 

protocol 

4. 
Reason of 

Validation 

The reason to carry out 

validation process either of the 

new, process, method or the 

equipment. 

5. 
Revalidation 

Criteria 

The need of revalidation such 

as change to any part or step. 

6. Responsibilities 

The responsibilities of every 

department should be 

mentioned appropriately. 

7. 
Reference 

Documents 

All appropriate documents 

(BMR, BPR, SOPs) should be 

mentioned. 

8. 
Procedure/Devi

ations 

Mention a stepwise procedure 

with required deviation. 

9. Conclusions 
All the obtained results as per 

acceptance criteria or not. 

10. 
Report/ Report 

Approval 

The report should be made 

with department approval 

 

 

 
  Confirmed Notes 

1. 

Whether the signature 

log book maintained 

or not 

  

2. 

Are the employees 

know about 

GMP.GDP, GAMP 

and 21CFR Part 11 

  

3. 

Is the all operating 

system update in the 

company? 

  

4. 

Is all the sheets used 

for calculation are 

validated or not? 

  

5. 

Is all the sheets have 

password protection to 

open the sheets or not? 

  

6. 

Is all the sheets have 

color coding system or 

not? 

  

7. 
Is the system have raw 

data captured 

  

8. 

All the sheets are 

properly named and 

coded 

  

 

9. 

Is the original data 

captured in readable 

form or not? 

  

 10. 

Is the sheets follow 

electronic signature 

model or not? 

  

 11. 

All information 

recorded both in paper 

and electronic form? 
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 12. 

All the sheets can be 

run on the entire 

version or not? 

  

 13. 

The sheets have 

acceptance criteria 

limits or not? 

  

  14. 

The sheets are 

provided with the 

VBA codes and Audit 

trails or not? 

  

 15. 

The sheets are 

provided with error 

and warning messages 

or not? 

  

 16. 

Sheets saved in 

appropriate formats as 

per SOPs or not? 

  

 

4. Results 

Validation Approach 

In terms of duties, the spreadsheet designer is frequently 

interchangeable with the researcher who is also in charge of a 

certain test methods. It must be ensured in this scenario that the 

programmer is constantly aware of his present job and that both 

the creation and validation stages are clearly divided. If 

modifications are required during the validation process, they 

must be reported, assessed, and tested again. Version control 

may be the core in handling changes, and essential 

modifications may be done with fewer efforts than using CSV.  

At last the approach of validating a spreadsheet is to assess the 

risk with short and systematic procedures in order to delete 

some steps of the process. 

 Development Process 

The sheets should be designed as per the user requirements or 

can be designed as a standard format for some common tests 

can be used as per the need. The key components of the sheets 

includes the password protection, color coding, locking and 

unlocking of the cell, limits as per the guidelines etc. 

User Requirement Specifications 

This includes calculations, formulas, layout, security and 

integrity of data, included in Functional Specifications. 

6.4 Designing of Excel sheet  

To depict a sophisticated spreadsheet design the sheet is 

divided into the colour coded area as shown in (Fig. 6.1) 

where, 

• First three rows (2, 3, and 4) contain heading as Test 

name, Sheet code, and Standard reference.  

• The next columns contains subheadings (G to P: ID 

No., Vol. and Strength of solution required, Name of 

compound, Formula Weight of compound, Weight of 

Compound taken and Points to remember ). 

• The heading and subheading cells are separated by 

different colours. 

• The designed sheets were easy to understand and 

colour coded as well. 

Input and output cells are separated and color coded as 

well: 

• The first three columns (G.H, I, J, and M to P) are 

INPUT CELLS in YELLOW COLOUR. 

• The next two columns (K and L) are OUTPUT 

CELLS in BLUE COLOUR. 

• The input cells are UNLOCKED CELLS while the 

output cells are LOCKED CELLS. 

• Formulas, Calculations and other parameters cannot 

be changed by the users in locked cells.  

•  

 
Fig.34 Spreadsheet Layout 

Development of Spreadsheet   

• Testing of spreadsheet efficiency as per User 

Requirement Specifications (URS) 

• The spreadsheets includes the formula auditing tools 

namely : 

1. Trace Precedents. 

2. Remove Arrows. 

3. Trace Dependents. 

4. Show Formulas. 

5. Error Checking. 

• The designed sheets must have these command as 

described in (Fig.35) 

• The sheets were tested for the formulas feeded for the 

calculations. 
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Fig.35 Formula Auditing Tools 

Trace Precedents. 

• Suppose we have the following formula in the L7 cell 

for calculating weight of the compound to make molar solution 

as shown in (Fig.36) 

 

Fig.36 Formula Auditing Cell 

• The arrows where trace precedents are highlighted 

with blue dots appears, as shown below in (Fig.37) 

 

Fig.37 Trace Precedents Arrow 

• The cells get bordered with various colors and written 

in the same color and cell reference as shown in (Fig.38). 

 

Fig.38 Formula Precedents Check 

 

• We can see that H7 is written with blue in the formula 

cell, and with the same color, the H7 cell is bordered. 

• In the same way, I7cell has a green color and K7 cell 

has a purple color. 

• This could be one of the ways including one more 

appropriate way to check precedents for the formula cell.  

Remove Arrows 

• The command was given the window appears and a 

click on the remove arrow just disappears the arrow seen on the 

sheet as given in (Fig.39). 

 
Fig.39 Remove Arrow Cells 

Trace Dependents  

• Select the K7 cell and click on the “Trace 

Dependents” command as shown in (Fig.40) 

• In the (Fig. 20), we can see the arrow lines where 

arrows indicate which cells are dependent on the cells i.e.K7 

dependent on L7 cell.  

• We will remove the arrow lines using the ‘Remove 

Arrows’ command. 
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Fig.40 Trace Dependents Cells 

Show Formulas  

• In (Fig.41), the cells containing formulas in the entire 

sheets are shown. 

• The sheet shows all the formulas from the average 

calculation to the every single function involved in the 

calculation. 

• The show formulas command allows to identify the 

cells containing the type and cells involved in the formulas. 

 
Fig.41 Show Formula Cells 

 

Error Checking 

• Once the command is given the error checking starts 

and ends with a pop message as shown in (Fig.42). 

 
Fig.42 Error Checking Popup Message 

 

VBA Code 

• The VBA codes should be should be properly 

reviewed line by line for the consistency, correctness, reliability 

and reproducibility as described in (Fig 43) 

 
                       Fig.43 VBA Code 
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Release for Qualification 

As soon as the development documentation is completed sheet 

and worksheet protection through password is installed and 

transferred for the documentation of qualification process. The 

recommendation of spreadsheet version is important. The 

sheets are than released for qualification. 

Installation Qualification 

To guarantee that the spreadsheet can be used across the testing 

facility, it may be important to verify that:  

• The spreadsheet can be operated on multiple 

computers (either identical or varied technology 

configurations, user profiles, or local settings). 

• The spreadsheet may be installed and operated on a 

variety of software platforms (Excel, OS, and, if appropriate, 

the data collection system). 

• The sheets should be flexible so that they can be 

saved on the server to make it useable for many users at same 

time. 

 

Operational Qualification (OQ) 

The result of making wrong entries into the cell such as 

mistakes in date format, text instead of numbers, incorrect 

decimal places, and real numbers instead of integers gives the 

error message as described in (Table 5). 

Table 5 Operational Qualification 

Testing as 

per URS 
Test 

Acceptance 

Criteria 

 

URS‐5. 

 

The spreadsheet 

should use the Unique 

ID No. for specific 

compound in the form 

of dropdown list 

wherever applicable. 

The error 

message “Please 

enters code from 

the dropdown 

list”. 

 

URS‐6 

The spreadsheet 

should indicate invalid 

entries with error 

messages and 

numerical value 

entries or any specific 

entries. 

The error 

message “Please 

enters numerical 

value 2, 12,4,15 

only”. 

 

URS‐7 

 

The spreadsheet input 

should only allow text, 

date, time and 

signatures as well 

alongwith the 

approval details. 

The error 

message “Please 

enter date and 

time as 

required”. 

 

URS‐8 

The calculations in the 

spreadsheet should be 

protected against 

unauthorised 

modifications on 

The error 

message “The 

cell or chart you 

are trying to 

clicking on the cell in 

the sheet. 

change is 

protected and 

therefore read‐

only” appears. 

 

Performance Qualification (OQ) 

It can be done by observing the following as: 

• By testing the input values in order to check the 

consistency by entering even the boundary values, all 

functional requirements and all the special and combination 

values . 

• By testing with real data been the major part of the 

validation process by taking real data as the input one. This 

input can be done manually or by importing the files. For 

achieving the high level of confidence a wide variety of data is 

used for spreadsheet testing. 

• This step makes sheets accurate, reliable so that their 

final copies can be tested for real data. 

• The accuracy and reliability of the sheets decides 

their usage and compatibility with the security purpose, 

unauthorized access and many more. 

• The qualification process is to ensure that the sheets 

will fulfill the predetermined standards. 

Spreadsheet Accuracy Test 

A. IPQC Test of TABLETS 

1. Layout 

• The color coding of the input and output cells are 

shown in (Fig. 44). 

 

 

 

 
Fig.44 Test sheet Layout 

 

• The freeze pane command can be shown in 

(Fig.6.12). 

 

 

 

 

INPUT CELL 

Freeze Pane 
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Fig.45Freeze Pane 

 

• The green and blue areas contain formulas in cells as 

given in (Fig. 46)  

 

 
Fig.46 Formulas 

 

Security and Protection 

Password Protection 

• Whenever unauthorized users try to manipulated data 

in the sheet they will get an immediate warning to unprotect the 

sheet. 

• The window appears as shown in (Fig.47) to enter 

password for opening of the sheet. 

 

Fig.47 Worksheet Password Entry 

 

• After the worksheet, the spreadsheet is also password 

protected as shown in (Fig. 48) 

 

Fig. 48 Protected Spreadsheet Window 

 

6.7.2.2 Cell Locking 

• Whenever unauthorized users try to manipulated data 

in the sheet they will get an immediate warning to unprotect the 

sheet as shown below in (Fig.49) 

 

Fig.49 Warning Message 

 

7.3 Logical Formulas 

• It consist of two logical commands as shown in the 

dialog box as given in (Fig. 50 & 51) 
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Fig.50 Logical Formula Window 

 

• Put commands in this box and Press ENTER  

 
Fig. 51 Logical Formula Command 

 

• Once the command is entered if both the command is 

“True” or “Pass” result displayed will also be “True” or 

“Pass” 

• The formula description is described  in (Table.6) 

Examples of Sheets containing Logical Formulas: 

There are some sheets containing logical formulas as shown in 

(Fig. 6.19, 6.20 and 6.21)  

➢ T

hickness, Hardness and Disintegration Sheet 

=IF (AND (K8<1, K8>0.5),"PASS","FAIL") 

 
Fig.52 IF, AND Formula 

➢ Dissolution Sheet 

=ROUND (MIN (J18:J23), 2) 

 
Fig.53 ROUND Formula 

 

➢ Weight Variation Sheet 

=ROUND (SUM (F8:F27), 2)/20 

 
Fig.54 SUM ROUND Formula 

 

Table 6 Formula Descriptions 

S.No Formula Description 

 

1. 
=IF (AND (K8<1, 

K8>0.5),"PASS",

"FAIL") 

Returns “PASS” if K8 

contains value less than 

1, greater than 0.5 and 

FAIL otherwise. 

 

2. 

 

=ROUND  

(MIN (J18:J23), 2) 

 

Returns MIN value from 

J18 to J23 cell than 

round it to 2 decimal 

places. 
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3. 

 

=ROUND (SUM 

(F8:F27), 2)/20 

 

Returns MIN value from 

J18 to J23 cell than 

round it to 2 decimal 

places. 

 

6.7.4 Calculation Formulas 

• The formula inserted occupies one cell each for easy 

and clear understanding of the calculation and formulas. 

• The formulas should be clear, concise and 

appropriately used. 

• Some sheets having calculation formulas are shown 

in (Fig. 6.22, 6.23, & 6.24) 

 

 

 
Fig.55 Dissolution Calculation Sheet 

 

 
Fig.56 Friability Calculation Sheet 

  

 
Fig. 57 Assay Calculation Sheet 

 

Conditional Formatting  

Examples of Sheets containing Conditional Formatting  

• The “Pass” result will show green colour with dark 

green text  

• The “Fail” result will show red colour with dark red 

text as shown in (Fig. 6.25, 6.26 and 6.27) 

•  

 
          Fig.58 Thickness, Hardness and Disintegration Sheet 
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Fig.59 Weight Variation Sheet 

 
Fig.60 Friability Test Sheet 

 

DATA VALIDATION 

Drop Down list menu  

• The dropdown list into the sheet was seen as shown 

in (Fig.6.28) 

 

 

Fig.61 Drop down list 

 

Examples of Sheets containing Drop down List 

a. Molarity Sheet: It contains compounds name in drop down 

list as shown in (Fig. 62) 

 

 
Fig.62 List of compounds 

 

b. Weight Variation Sheet: It contains test name in drop down 

list as shown in (Fig. 6.30) 
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Fig.63 Test Name List 

 

Data Input and Error messages  

• The input of invalid data (e.g. alphanumerical data in 

numerical fields, out‐of‐range values) can be intercepted (Table 

7). 

 

Table 7 Data input and Error messages 

 
 

6.7.6.3 VBA Code 

• Click on the VBA code to open the window showing 

VBA codes, then click on the desired code to open the VBA 

code command to do this click on: Project Explorer> VBA 

Project Personal> Modules> Choose the desired module as 

given in (Fig.64). 

 
Fig. 64 VBA Code List 

 

• The VBA code coding can be obtain by clicking on 

the module than on the desired code to run it as given in 

(Fig.6.32) 

 

Fig.65 VBA Code 

 

• Save your workbook as "Excel macro-enabled 

workbook". 

• Press Ctrl + S, then click the "No" button in the "The 

following features cannot be saved in macro free workbook” 

warning dialog as given in (Fig.6.33). 

•  

 
Fig.66 Macro Workbook Warning Window 

• The "Save as" dialog will open as shown in 

(Fig.6.34). Choose "Excel macro-enabled workbook" from the 

"Save as type" drop-down list and click the Save button. 
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Fig.67 Macro book saving dialog box 

 

How to run VBA macros in Excel 

When you want to run the VBA code that you added as 

described in the section above: press Alt+F8 to open the 

"Macro" dialog. Then select the wanted macro from the "Macro 

Name" list and click the "Run" button as shown in (Fig.68). 

 
Fig.68 Macro Run dialog box 

Audit Trail 

• The changes done in the sheet are tracked in new 

sheets as shown in the (Fig.69). 

 
Fig.69 Tracked Changes Sheet 

 

Excel Auditing Tool and Watch Window 

• The error checking can be done for the entire sheets 

and the message is displayed as shown in (Fig.70) 

 
Fig.70 Error Checking Message 

 

• The formula auditing can also be done by using 

watch window which shows how change into one cell brought 

the change into other. 

• The watch window can been in (Fig.6.38). 

 
Fig. 71 Watch Window Command 

 

Addition of Hyperlink  

• The added hyperlink can be seen on the sheet as 

shown in (Fig.6.39) 

• One click on the hyperlink takes to the document or 

the image, draft from where it is inserted. 

 
Fig.72 Hyperlink Cell 
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Validation Protocol 

The protocol should be follow while performing the excel sheet 

validation: 

1. Protocol Approval: Protocol should be made and approved 

by the QA department. 

2. Purpose: The objective of this protocol is to assure the 

validation of excel sheets used for calculation purpose. 

3. Scope: This protocol shall be followed by the QA personnel 

while doing the testing to assure product quality. 

4. Reason of Validation: The validation of excel sheet was 

carried out to maintain the data security, integrity and accuracy. 

5. Revalidation Criteria: The revalidation of excel sheet 

depends upon the change in the  

• Computer Version no. 

• Software Update 

• Calculation, Formulas, Acceptance Criteria, color 

coding etc. 

• Guidelines, Users and Procedures 

6. Responsibilities: Following departments are responsible for 

the validation as follow:   

• IT Department: Handles the password protection 

and any unauthorised excess. 

• Quality Control: Prepares procedure for excel sheet 

validation as per SOP. 

• Quality Assurance: QA head is responsible for the 

approval and implementation of protocol properly. 

7. Reference Document: All the documents taken for 

references shall be properly checked and approved. 

8. Procedure/Deviations: 

• To prevent unauthorised access to the files, a file 

must be password protected or should be in the read-only 

status.  

• The cell containing formulas or involved in 

calculation must be locked to maintain data accuracy and 

integrity. 

• The version of the operating systems shall be fixed to 

prevent any problem during the change or revalidation. 

• The format of the sheets should be fixed and such that 

it the header contains the Product name, Sheet code, Test name, 

Batch no. and company name , logo (if applicable) 

• The middle part shall contain the calculation, where 

entry to be filled from Raw Data Sheet, formulas and the 

information needed to make results. 

• The footer of the sheets must contain the in-out 

timing, start-end date alongwith the prepared, checked and 

approval information with the signature. 

• The formula should be written in the corresponding 

cells for reference. 

• The conditional formatting should be done to assure 

the acceptance criteria as well as the entry into the cell should 

also be color coded. 

• The sheets should be saved with the respective name 

such as assay, dissolution, disintegration etc. 

 

9. Conclusion: The sheets should be saved in ready only mode 

with authorized persons signature as shown in (Fig.6.40) 

 

 
Fig.73 Approved Final Sheet 

 

10. Report/ Report Approval: 

The sheets should validate and every action should be 

documented and sent to the appropriate departments and 

personnel for its approval. 

CONCLUSION 

This research has introduced a simplified and efficient method 

for validating Excel spreadsheets. This method combines 

industry best practices into two comprehensive documents, 

with more specific information to follow in upcoming articles. 

By following these principles, it is possible to fully validate and 

implement a standard spreadsheet in less than four days. This 

approach offers a practical solution to the widespread issue of 

compliance, minimizing risk through an affordable and 

consistent process. It is adaptable to various quantities of 

spreadsheets and can be easily integrated into a company's 

computer systems validation policies. 

Read Only Mode 
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Spreadsheet creation often point out that the process of creating 

spreadsheets is more casual in nature, and only a small number 

of organizations possess thorough guidelines for spreadsheet 

development. While there are instructive pieces that emphasize 

practices like modular design and including sections for 

assumptions, these might not hold as much significance as other 

advancements, particularly the meticulous inspection of 

individual cells' code following the development stage. 

Acknowledgments involve the installation and checkout phase, 

which requires shifting the application software from the 

development lab to the plant site. Upon installation on-site, 

functional testing with the process can commence. Before this 

phase starts, a procedure for documented change control (defect 

identification, review, software and document updates) must be 

defined and implemented. Outputs encompass functional test 

results, change control reports, and a validated computer 

system.  

The sheets provide the accuracy maintenance of data and 

calculations in order to protect the data from any unauthorised 

access. The good documentation and manufacturing practices 

alongwith the regulatory authorities made it important for 

getting regulatory compliance. Validation of process, 

equipment plays important role in assuring the quality of 

product while the excel sheets ensure the data integrity and 

protection from any modification. Therefore it necessary to 

validate the excel sheets as per the reference documents and the 

given guidelines to assure quality of the product as well as the 

generation of the quality data. The necessary steps required to 

validate an excel sheets are also shown here.  
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